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Notice 
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circuit described herein. All graphs show typical data and not the measurement values of the individual 
product delivered with this manual. Seibersdorf Labor GmbH does not convey any license under its 
patent rights or the rights of others. 
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1. INTRODUCTION 
 

CalStan 11 is a software tool for automation of radio frequency (RF) calibrations and measurements. The 
software controls the instruments via GPIB bus or LAN, reads the measurement values and computes the 
results. The purpose of the software is to perform calibrations and validations of equipment, such as 
antennas, cables, test sites and test setups.  

Every measurement type is implemented as a plug-in to the base application. This way the software can 
be extended to new functionalities. Similar approach is used by implementation of device drivers, so the 
support for new measurement equipment can be added on customer request. 

This manual describes in detail the usage of the software with currently available measurement types.  

 

Check at https://rf.seibersdorf-laboratories.at/products-services/products/calstan for the latest version. 

 

 

 

What is New in CalStan 11? 
 

1. Complete GUI redesign to improve user experience 

2. Complete reimplementation of measurement modules for more effectivity during measurements 

3. Added new measurement procedure Site Insertion Loss (Loop) 

4. New functionality in drivers, e.g. Antenna Mast polarization control available. 

 

 

For up-to-date changes history you can look in the Help Menu in the “About” section. 

 

 

 

 

https://rf.seibersdorf-laboratories.at/products-services/products/calstan
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2. SYSTEM REQUIREMENTS 
 

 

Operating systems 

Windows 7  
Windows 8  
Windows 8.1  
Windows 10 

Minimum computer requirements 2 GHz CPU 
4 GB RAM 

Additional hardware National Instruments GPIB card or GPIB-USB-HS interface 

Installed software .NET framework version 4.8 (or higher) 1 
National Instruments Runtime v18.5 2 

Table 1: System Requirements 

 

A list of the supported measurement instruments can be found in the Help Menu in the “About” section 

 
1 The .NET framework can be downloaded from https://dotnet.microsoft.com/download/dotnet-
framework/net45 
2 National Instruments Runtime is usually shipped with the GPIB card. 

https://dotnet.microsoft.com/download/dotnet-framework/net45
https://dotnet.microsoft.com/download/dotnet-framework/net45
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3. INSTALLATION AND UPDATE OF CALSTAN 11 
 

3.1. Installation 
 

The CalStan 11 software can be downloaded from our webpage https://rf.seibersdorf-
laboratories.at/products-services/products/calstan free of charge and installed on your local computer. 
After installation it runs with all its features, but data saving is restricted if the user doesn’t possess a 
license for specific measurement types. So, the supported test instruments and the compatibility can be 
checked and the licensed can be ordered when satisfied. 

 

The standard way of CalStan 11 distribution is on an USB memory stick, which serves as a dongle at the 
same time. The dongle contains the license files for the user specific measurement types. If it is not 
connected to the PC, the saving of data is disabled. Licenses for additional measurement types can be 
obtained later if desired.  

 

After executing the “CalStan11_setup.exe” file, an installation dialog pops up.  

 

 

Figure 1: Setup – Welcome dialog 

https://rf.seibersdorf-laboratories.at/products-services/products/calstan
https://rf.seibersdorf-laboratories.at/products-services/products/calstan


9 | SEIBERSDORF LABORATORIES  CalStan 11 MANUAL |  

Clicking the “Next” button a window appears where the dialog (Figure 2) where you can select 
measurement modules to be installed. 

 

Figure 2: Measurement modules selection dialog 

 

Clicking the “Next” button a window appears where the installation destination location can be selected 
(Figure 3). We recommend using default one. After a selection of the destination folder for CalStan 11, to 
start the installation procedure, click the “Install” button, to go one step back press “Back” or “Cancel” to 
quit the installation. 

 

 

Figure 3: Installation directory selection dialog. 
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When the installation was completed successfully a new dialog pops up: 

 

 

Figure 4: Setup – CalStan completed dialog 

 

By clicking “Finish” the CalStan 11 setup ends, and an icon appears on the desktop. 

 

 

Figure 5: CalStan Icon 

 

Run CalStan 11 from the start menu group or the icon on the desktop. If the start menu and the desktop 
shortcut were not installed, execute CalStan 11 from the installation folder. 
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3.2. Update 
 

By clicking the red caption in the right top corner of the application window (Figure 6) an online updater 
application starts. This serves for keeping CalStan up to date. If an internet connection is available, the 
updater checks our remote server for newer versions of software components. 

 

 

Figure 6: Update available indicator 

 

This way the user can install new device drivers and get latest bug fixes. 

 

 

Figure 7: Online application updater. 

 

 

Clicking the update button, the update process starts. After successful completion, CalStan is restarted 
automatically. 

 

Note: the updater doesn’t work behind the proxy server. 
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If internet connection is not available CalStan can be updated to newest version 
manually in the following steps: 
1. Download new CalStan installer from: 

https://rf.seibersdorf-laboratories.at/products-services/products/calstan 
2. Uninstall old CalStan version. In the process of uninstallation, you should be 

prompted for deleting the ‘Session’ directory. If not, delete this directory 
manually. It resides in CalStan installation location. 

3. Install new CalStan version by running the downloaded installer. 
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4. QUICK START 
 

In this chapter the typical steps to start a measurement campaign are described. Some measurement 
types may be more complex - but the basic procedure does not change. 

1. To start a new measurement, choose "File->New…" and select the desired measurement type. 

2. Modify the parameters in the “Measurement settings” panel (in the upper left part of the screen). 
Most common ones are the frequency range, frequency step, measurement bandwidth and limit. 
If needed load some factor files (e.g. Antenna Factor or Cable Loss file).  

3. Set your measurement devices by the Menu Hardware/Select Devices. If possible CalStan sets 
the proper device driver for connected devices, if not you have to choose driver manually from 
the driver list. 

4. Set the parameters of the test instruments below the “Measurement settings” if necessary (e.g. 
select input 1 or Input 2 of the receiver) 

5. Select the measurement position and run the measurement by clicking the “Start” button (lower 
left corner of the start measurement panel on the right side of the screen). If settings are incorrect 
the software shows an info message with instructions. 

6. To save the measurement go to “File->Save”. 
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5. CALSTAN 11 WORKSPACE 
 

The CalStan 11 main window (Figure 8) consists of three main parts: 

A Menu bar – shows main menu related to a currently opened measurement  

B Measurement list bar – contains a list of currently opened measurements 

C Measurement window – represents the currently opened (active) measurement 

 

Figure 8: CalStan main window 

 

The measurement window can be divided into sub areas (panels) 

1. Measurement display – shows the measurement data in a chart 

2. Measurement settings – defines parameters for the measurements 

3. Instrument settings – contains settings for the selected instruments 

4. Chart Data – shows the table of data as currently displayed in the measurement display 

5. Measurement control panel with the “Start” button – controls the measurement sequence 

 

 

A 

B 

C 
1 

2 

3 

4 5 
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The individual window panels are sizable. By clicking the button  or , selected window panels can 
be maximized/minimized (Figure 9).  

 

 

Figure 9: Measurement window with measurement settings, hardware settings and chart legend 
panel minimized. 
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6. MENU BAR 
 

The menu bar is located at the top of the main window. It contains several menus which are described in 
the following. 

 

6.1. File Menu 
 

 

Figure 10: The file menu 

New Creates a new measurement. 

Open Opens a previously saved measurement. Opening of the CalStan 10 
measurements are also supported with some measurement module 
specific limitations.  

Create Factor Data… Opens dialog where the factor data file can be created (e.g. Cable loss) or 
imported from CalStan 10 file. 

Save 
(disabled in demo mode) 

Saves a measurement.  

The default file extension of the CalStan 11 measurement files is “.c11”. 

Save As  
(disabled in demo mode) 

Saves a measurement with a user defined file name into an individual 
directory. 

The default file extension of the CalStan 11 measurement files is “.c11”. 

Save Template… Saves a measurement as a template. Template can then be used for 
creation of new measurement of the same type with the same settings. 

Recent Files List of recently opened files which can be reopened. 

Exit Closes the CalStan software. 

User is asked to save changes. If changes are discarded the measurement 
is closed automatically. If changes are saved or there were no changes 
made recently in opened measurements, CalStan exists and at the next 
startup all saved measurements are reloaded. 

Table 2: File menu 
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In the New measurement dialog (Figure 11) two panels are shown: 

 

Measurements panel contains available measurement types. Selection from the list creates the specific 
measurement using last measurement settings and instruments for this type. The measurement positions 
are set to default. This Template is created automatically on measurement start/measurement saving. 
“Last” label contains name of the last created measurement or template. 

 

Templates panel contains both automatically and manually created measurement templates with 
measurement settings, instruments and measurement positions names. 

Clicking Folder icon in the top right corner opens the templates directory in the file browser. 

 

Figure 11: New measurement dialog 

Note: There is a possibility that the previously saved mesurements/templates have compatibility issues 
with the latest CalStan software version. If this is the case, the message box is shown on actual file 
opening. 

 
The opened measurement compatibility issue is indicated by yellow icon in the measurement tab. 

 
It is not possible to save incompatible measurements as template. 
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6.2. Measurement Menu 
 

The measurement menu contains general options related to the active measurement. 

 

Figure 12: The measurement menu 

 

Measurement Info Opens a collection of general measurement information (Figure 13) in a 
dialog box.  

Some of the parameters are editable; others are locked as they are 
overtaken from measurement and hardware settings, indicated with the 
lock symbol 

Recalculate Results Recalculates the results of an active measurement. 

Results can be recalculated only if certain measurement specific 
conditions are fulfilled. 

Table 3: Measurement menu 
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Figure 13: Measurement info dialog box 
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6.3. Hardware Menu 
 

The hardware menu contains general options related to measurement devices used by CalStan. 

 

 

Figure 14: Hardware menu 

 

Select Devices Shows dialog (Figure 15) where the measurement instruments can be 
selected manually or detected automatically.  

Clicking the “Detect” button, the detection process of GPIB/TCPIP/USB 
connected devices starts. If the detection procedure is successful, a 
dialog box with a list of devices pops up, showing information about 
device manufacturer, model and communication interface. Individual 
devices/appropriate driver versions can be selected then. 

Next to the “Detect” button is a search field where user can type an 
instrument manufacturer, model or type according to which the table 
below is filtered. The table also contains information about the device 
driver version, CalStan version the driver was created for and 
communication interfaces the driver supports. 

Manual instrument/driver selection is accomplished double-clicking the 
table row or clicking the “+” button. 

The “Selected Devices” panel contains all selected devices/drivers. Only 
one device of the same type can be selected (existing ones are 
replaced). By closing the Device Selection dialog box using the “Ok” 
button, the selected devices drivers are displayed in the Devices panel. 

For each measurement module (procedure) there are defined appropriate 
device combinations. Device selection dialog will not allow exit on “Ok” 
button click if selected device doesn’t fulfill the criterion. 

Verify devices This functionality detects connected devices and checks if all of the 
selected devices in the measurement settings are present. The address 
and interface is updated, devices pre-initialization is triggered and valid 
measurement parameters are updated. This works only for NI Visa 
devices. 

Lock Devices Controls the device locking mechanism to prevent simultaneous use of a 
device by different measurements. 

Table 4: Hardware menu 
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Figure 15: Device Selection Dialog, see Table 4 for explanation 
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6.4. Tools Menu 
 

The tools menu contains various options applicable to an active measurement. 

 

 

Figure 16: Tools menu 

 

Create Report 
(disabled in demo mode) 

Creates the measurement report according to the active measurement 
procedure. The report is saved in MS Excel file format, in a user 
defined directory. In general, the report contains measured data as well 
as computed results together with all settings used during the 
measurement. See specific measurement procedure for further details. 

Export Height Scan Data Saves the heights scan sweeps data in MS Excel file format. This 
function is available only in the measurement types which includes 
height scan. 

Table 5: Tools menu 
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6.5. Help Menu 
 

The help menu contains software related information, such as access to the manual and a list of installed 
components. 

 

 

Figure 17: Help menu 

 

Manual Opens the CalStan manual which is stored in pdf format (Adobe Acrobat 
Reader or other pdf reader application is needed). 

Reset Session Session reset deletes hardware session data and automatically saved 
measurement templates. 

Start Previous Version Starts last version of Calstan (before update). This is useful when 
something doesn’t work after update. 

Create Report Error If you encounter problem with our software, by this item you can generate 
special report file. Send us this file together with your problem description 
and we will provide you with our support. 

Start Remote Support If problems occur with a measurement performed by CalStan, we can 
provide you with online support directly at your computer. The computer 
needs to be connected to the internet and the “Ready to connect” icon 
has to show at the bottom of the quick support dialog (Figure 18). By 
sending us the ID and Password you allow us to remotely control your 
computer and to examine the problem directly. This is necessary if there 
is some specific device error, which can’t be reproduced at our side. 

About Opens a dialog box which shows various information about the installed 
CalStan software including program version and a list of the installed 
measurements (Figure 19) and device drivers (Figure 20). It also 
contains version changes history (Figure 21) and system information 
(Figure 22). 

 

Table 6: Help menu 
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Figure 18: Quick support dialog for remote control 

 

 

Figure 19: Dialog boxes in the About dialog, showing the installed and licensed measurement 
modules 
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Figure 20: Dialog boxes in the About dialog, showing the instrument drivers 

 

 

Figure 21: Dialog boxes in the About dialog, showing the latest changes in the software 

 

    

Figure 22: Dialog boxes in the About dialog, showing system information 
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7. CALSTAN 11 SETTINGS 
 

This section describes parameters used in most measurement procedures. 

 

7.1. Measurement Settings 
 

The measurement setting panel is located in the upper left corner of the main window (Figure 8). It 
contains all measurement specific parameters such as frequency range, frequency steps and others. For 
measurements which involves height scan of the receive antenna, the “Receive Antenna Height” 
parameters defines the mast movement. The start/stop heights and movement type (discrete or 
continuous). The height scan can be also disabled by setting the “Heightscan” parameter to “None”. 

 

 

Figure 23: Measurement settings panel, for e.g. Site VSWR measurement 

 

7.1.1. Frequency Step 
 

Measurements with CalStan 11 are done at discrete frequencies (frequency steps). The discrete 
measured points are displayed as a line plot in the measurement display window. Measurement results 
are only correct if the frequency resolution is high enough to cover any 'peaks' or 'resonances' within the 
measurement range.  

 

These frequency steps are defined in the “Frequency Segments” dialog box which can be opened by 
clicking the folder icon in the related row of the measurement settings panel. 

 

In the “Frequency Segments” dialog box (Figure 24) the frequency resolution of several frequency bands 
can be defined individually. The frequency bands must not overlap. 
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Open the frequency step dialog box by clicking on the folder symbol. In the pop up window frequency 
steps can be edited, additional frequency steps can be inserted or existing ones deleted by right mouse 
click. 

 

 

Figure 24: The „Frequency Segments“ dialog 

 

The frequency steps can be loaded from or saved to a file using the “Open” and “Save” buttons. The 
frequency steps are classified as an interval dependent parameter; for this file type the file extension 
“.cfs” is used. 

The default frequency steps are recommended for most of the measurement procedures and can be 
restored by clicking the “Default” button. 

 

It is also possible to set some measurement parameters as frequency dependent by selecting the 
“Param” value from the parameter values list (e.g. Rbw parameter in Figure 25). 

 

 

Figure 25: Parameter dialog 
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Then in the „Frequencvy Segments“ dialog, specific parameter value (see Rbw in Figure 26) can be 
defined for each frequency segment (range). 

 

Figure 26: The „Frequency Segments“ dialog with measurement parameters 

 

7.1.2. Limit 
 

To determine if the measurement results range within a particular tolerance, limit boundaries are defined 
for specific frequency intervals. These intervals are specified in the “Limit” dialog box (Figure 28, Figure 
29) which can be opened by clicking the folder icon in the related row of the measurement settings panel. 
When the result chart is viewed, the limit data are displayed too.  

 

Figure 27: The limit boundaries in the measurement result chart 
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Figure 28: The „Limit“ dialog box with the data view 

 

 

Figure 29: The „Limit“ dialog box showing the graph 
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7.1.3. Factor files 
 

Some measurement types require various factor files to be set in their measurement settings. This 
involves cable loss factor, transmit/receive antenna factors, dual antenna factors and others. Clicking the 
folder button in the measurement settings panel of a factor file parameter, opens the factor file dialog. 
This dialog contains three tab pages: 

1. Data page – shows factor data (see Figure 30 and Figure 31) 

2. Chart page – here the factor data chart is shown (see Figure 32) 

3.  Info page – displays description of the given factor measurement (see Figure 33) 

 

Both data and info page can be modified using context menu. 

 

Figure 30: Factor file dialog – Data tab for Dual Antenna Factor 

When more than one factor is available you need to choose the one to use, see Figure 31 where 
“Attenuation T2” is selected as example. 

 

 

Figure 31: Factor file dialog – Data tab for Cable Loss 
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Figure 32: Factor file dialog – Chart tab 

 

 

Figure 33: Factor file dialog – Info tab for Dual Antenna Factor 

Note: In the GUI where the factor file editing dialog can be opened, is displayed file name or "Not saved” 
if a filename is not present and there are factor data available. 
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File Menu 

 

Figure 34: The file menu 

 

Open Opens a previously saved factor file.  
CalStan factor files have extension cff. 

Import from file… Imports factor data from a text file. In the Info tab page, the factor 
measurement description can be filled out. Then switching to Data page 
a text file containing the physically measured values can be loaded. This 
can be a tab-separated file exported from MS Excel spreadsheet (File-
>Save As... – Data Type = Tab-Separated values file). The exact format 
of the “.data” file is shown in separate dialog (Figure 35) if the Help 
button is pressed. Factor files imported this way can then be saved in the 
CalStan 11 native format to make loading the data more convenient 
when needed next time. 

Import from clipboard Imports factor data from clipboard. In this way the data can be copied 
conveniently from MS Excel spreadsheet and pasted here. 

Save… Saves a measurement as a template. Template can be then used for 
creation of new measurement of the same type with the same settings. 

Clear List of recently opened files which can be reopened. 
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Figure 35: Help dialog – Dual Antenna Factor import file format. 

 

7.1.4. Measurement specific hardware parameters 
Measurements have to be done according to certain requirements defined in standards or SOPs. This 
could be the measurement bandwidth (RBW) for example. In Figure 36 the measurement specific settings 
when a network analyzer is used are shown.  

 

 

Figure 36: Measurement settings for network analyzer. 

The settings of the network analyzer for a specific measurement are used for all different models of 
network analyzer as they are defined in the measurement setting.  
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7.2. Instrument Settings 
 

To setup instrument related device parameters, a panel similar to one displayed in Figure 36 is present in 
the ‘Measurement/Device Settings’ part of the application (Figure 37). For every model a separate panel 
exists. For illustration purposes the Agilent Technologies E5071C network analyser driver is used.  

 

 

Figure 37: Instrument info and parameters. 

 

The panel contains general information about the device such as manufacturer, model, frequency range 
etc. These values have only informative character and can’t be edited. 

 

To communicate with an instrument the address parameter has to be set correctly. In case of GPIB 
devices, the address is detected automatically if (see “Detect” button in the “Select Devices” dialog from 
Hardware menu (see 6.3). For instruments connected via other interfaces (R232, Ethernet) the address 
has to be set manually. 
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8. MEASUREMENT CONTROL 
 

Every measurement type contains the ‘Measurement Control’ panel where the measurement 
configuration is selected, and the measurement is started from. For the sake of completeness all features 
of the measurement control panel are described in this chapter. 

As an example, the panel of a Site VSWR measurement is shown. The layout is divided into two tabs.  

 

The “Positions” tab (Figure 38) shows a table with a list of measurement positions. Its columns have the 
following meanings: 

The name of the position - when clicked, the position is set active and is highlighted in the chart. 

Number of traces measured at the position. 

In the context menu (mouse right click) a picture can be assigned to the position (drag&drop functionality 
is also supported). 

 

  

Figure 38: Measurement Control panel with Positions view 

 

The “Traces” tab (Figure 39) includes a table with a list of measurements finished at the active position. 
The columns have the following meaning: 

Trace number 

Comment – short text describing the measurement (user defined; after a second measurement of the 
same measurement point, the input of a comment is requested) 

Indicator (green dot) – shows which trace is considered as the final (used for results computation – in 
some measurement types whole results are recalculated if this is changed). To set a specific trace active 
use the context menu “Set as active” function from the context menu. 

In the context menu a picture can be assigned to the trace (drag&drop functionality is also supported). 

 



 36 | CALSTAN 11 MANUAL  SEIBERSDORF LABORATORIES 

 

Figure 39: Measurement Control panel with Traces view 

 

The “Timeline” tab (Figure 40) includes a table with a list of measurements (traces) in the order they were 
finished. In the context menu (mouse right click) the measurement timestamp can be examined as well as 
a picture can be assigned (drag&drop functionality is also supported). Trace timestamp is stored in UTC 
format and converted to local time when displayed. 

 

 
 

Figure 40: Measurement Control panel with Timeline view 
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In the “Layout” tab a graphic shows the layout of a currently active position (Figure 41 left). With the radio 
buttons the desired measurement position can be selected conveniently. Finished positions are indicated 
by green color. Slider control at the bottom of the panel can be used to adjust the measurement setup 
orientation (left/right). 

In the “Picture” tab is displayed an image associated by the selected Position/Trace. Images are saved as 
1500pixel jpeg of 75% quality level. One picture consumes 190kb of file space. Supported image file 
formats: BMP, GIF, JPEG, PNG, TIFF  

 

 

Figure 41: Layout view (left) and Picture (right) 

 

By clicking the “Start” button in the measurement control panel (Figure 42) the measurement procedure is 
started.  

 

Figure 42: Start measurement. 

 

When the measurement is started for the first time or the receiver parameters were changed, the devices 
are initialized. 

When the test instrument is a network analyzer and its S-parameter is set to S11 or S22, the calibration 
dialog box appears (Figure 43). The calibrate behavior can be controlled by the calibrate parameter which 
appears in the measurement settings panel (Figure 36) on some types of instruments. If the parameter is 
set to auto, the message appears only if the device was initialized, and the S-parameter is set to S11 or 
S22. Other options are “Yes” which shows the message always or “No” in which case the message will 
not be shown despite of the device initialization or S-parameter setting. 

 

 

Figure 43: Devices calibration dialog box. 
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At this point some device settings can be changed manually before the measurement is started. After the 
“Ok” button is pressed the measurement starts immediately. The devices are initialized only once at the 
first start of the current measurement or if the receiver parameters changed.  

 

During the measurement the “Start” button is replaced by a “Stop” button. A progress bar shows the 
advance of the measurement. At the same time the measurement chart area is changed to the 
“Measurement” display, which shows measurement data as they are read from the devices. At the very 
bottom of the measurement control panel a status panel indicates the antenna position (distance). 

 

 

Figure 44: Measurement progress bar 

 

To stop the measurements, click the “Stop” button. The suspend measurement dialog box pops up 
(Figure 45) and all devices stop immediately. There are several options how to proceed further: 

1. Stop the measurement and discard the data measured so far (since the start button was 
pressed). Click the “Stop” button for this option. 

2. Stop the measurement and preserve the data measured so far. Click the “Accept” button for this 
option. 

3. Resume the measurement – continues the measurement from the stop position. Click the 
“Resume” button for this option. 

 

 

Figure 45: Suspended measurement dialog box. 

 

During the measurement the data is displayed in the “Measurement” tab of the chart area. 

 

Tip: To play a notification sound on successful measurement finish, create file: 

 c:\Users\[user name]\AppData\Roaming\Calstan 11\sounds\measurement_finished.wav 

(e.g. you can download and rename https://upload.wikimedia.org/wikipedia/commons/5/55/Buzzer.wav) 
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9. RESULTS - MEASUREMENT DATA DISPLAY 
 

By default, the results are calculated only for active traces. Results are calculated on measurement 
finished or Active trace change. Recalculation can be executed explicitly by clicking Measurement-
>Recalculate Results. 

 

 
 

The measurement data and the results of the measurement are displayed in the chart area in the 
appropriate tabs which are described in this chapter. 

  

The first tab (“Measurement”) shows the actual measurement data during a measurement progress. After 
measurement is finished sweep data at specific position (e.g. height scan) are shown if available, 
otherwise the active trace is displayed (Figure 46). 

 

 

Figure 46: The measurement display 



 40 | CALSTAN 11 MANUAL  SEIBERSDORF LABORATORIES 

The next tab marked as “Traces” shows raw or e.g. maxhold measurement data after a measurement is 
finished (Figure 47). 

 

 

Figure 47: The traces display. 

 

The “ΔSA” tab (Figure 48) shows the calculated results for NSA FAR measurement and the specified limit 
boundaries. Some measurement procedures can have more than one result tab and can display various 
data. 

 

 

Figure 48: The results display with data tab selected 
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Using the chart context menu (Figure 50) it is possible to switch between linear and logarithmic scale of 
the domain axis, reset chart zoom, copy/save chart image or set displayed data frequency units. 

 

 

Figure 49: Chart context menu. 

 

The “Chart Data” tab (see right part in Figure 46 to Figure 48) holds a table of values displayed in the 
chart. The first column always contains the domain axis values (e.g. frequency) and the other column 
refers to the range axis values of the specific curve. Data from this table can be copied to the clipboard by 
selecting the appropriate rows/columns (hold “Shift” key for multi selection) and pressing “Ctrl+C” key 
combination. Then the data can be pasted (“Ctrl+V”) e.g. to MS Excel, for further processing. Clicking the 
table cell will highlight the given point in the chart, and similarly clicking the curve point in the chart will 
select the appropriate cell in the table. 
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10. MEASUREMENT MODULES 
 

Different measurement procedures are described in this section. 

 

10.1. Site VSWR 
 

In CISPR 16-1-4 [1] a technique to validate fully anechoic rooms in the frequency range 1 – 18 GHz is 
described. This method is called Site VSWR. 

The POD Antenna and the POD Antenna Stand developed by Seibersdorf Laboratories are designed for 
this purpose. The software CalStan 11 controls measurement instruments (e.g. a network analyzer) to run 
the tests. Not all information required to perform a Site VSWR test is included in this manual, but it gives 
guidance how to use the products. 

 

d

Measurement axis
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volume
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L6 to L1

R6 to R1

Antenna

 

h1 

Top

 

 
floor absorbers 

h2 
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Figure 50: Location of test points for Site VSWR 
a) top view 
b) side view 

 

In Figure 50 the heights h1 and h2 are depending on the test volume of the chamber. The height h1 is 
either half of the height of the test volume, but maximum 1 m and h2 is the height of the test volume (see 
also at CISPR 16-1-4). 
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Also the locations of the test positions according to the standard are shown. Each location requires a 
sequence of six points on a line to the receive antenna reference point. These six positions are distributed 
unequally over a 40 cm line. For this purpose, scan distance segments are predefined (Figure 51). 

 

 

Figure 51: Scan distance segments definition: this setting will generate the standard positions at 
0 cm, 2 cm, 10 cm, 18 cm, 30 cm and 40 cm. 

 

10.1.1. Setup 
 

Allowed measurement instrument combinations: 

Preferred Inst1 Inst2 Inst3 

x Network Analyser - Positioner 

 Signal Generator Spectrum Analyser Positioner 

 

Before starting the measurement, all measurement parameters have to be defined in the "Measurement 
Settings" panel (Figure 53, lower left).  

For a volume diameter of 1.5 m and less the Center position must not be measured. When the volume 
height is set the H1 and H2 values are calculated automatically. If the volume height is lower or equal to 
1 m the top position does not need to be measured. 

The frequency range is set to 1 GHz - 6 GHz when using the POD 16 and to 6 GHz – 18 GHz when using 
the POD 618. Please check the frequency segments configuration for consistency with the standards 
requirements of 50 MHz step size. 

The POD antenna can be positioned manually or using automated SPA2 positioner. In Figure 52 the 
available positioner drivers are listed. 
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Figure 52: Site VSWR Antenna Positioners. 

The automated positioner measures all positions which are selected in the positions table, one after 
another. When using manual positioner, a message box with desired position information is displayed at 
each position. 

 

 

Figure 53: Site VSWR window 
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10.1.2. Using SPA2 Automatic Site VSWR Positioner 
 

The SPA2 detection can be done automatically (Select Devices) or the COM port for remote control can 
be set manually in the instrument specific hardware settings (Figure 54). By clicking the Controller GUI a 
specific tool allows the check of the proper instrument operation and for moving to the “Home” position 
manually. 

 

 
 
 Figure 54: SPA2 Controller GUI 

 

Using the automatic positioner, the measurement procedure can be highly automated. By selecting 
desired position, setting up the antenna on the corresponding location and clicking the start button, the 
positioner moves the antenna to correct distances in the 40 cm line and performs the measurements. 

 

 

Figure 55: Selecting position to be measured 
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10.1.3. Measurement Procedure and Result Calculation 
 

The measurement campaign of the Site VSWR contains 60 measurements at maximum. Six positions (1-
6) are measured at 5 locations (left, right, center, front and top) for 2 polarizations (horizontal, vertical). All 
six positions are depicted in the start measurement panel as shown in the right part of Figure 55. 

 

The results for a specific location e.g. center horizontal (index “A”) are calculated when the last of the 
appropriate six positions “i” is measured. This means, that if a user decides to re-measure one of the six 
already finished positions, the result is recalculated. If a user sets different traces of a position active, the 
result is also recalculated.  

 

The result for a specific location with index “A” is computed as follows: 

 

VSWR A = max (modifA,1, modifA,2, … , modifA,6) – min (modifA,1, modifA,2, … , modifA,6) 

 

where    modifA,i = corrA,i + mesA,i     

 

with: 

corrA,6 = 20 * log10((D + 0.00)/D), 

corrA,5 = 20 * log10((D + 0.02)/D), 

corrA,4 = 20 * log10((D + 0.10)/D), 

corrA,3 = 20 * log10((D + 0.18)/D), 

corrA,2 = 20 * log10((D + 0.30)/D), 

corrA,1 = 20 * log10((D + 0.40)/D), 

 

mesA,i is a measured value at the specific location “A” in position “i” 

where 

 

D = d     for front and top location, 

D = d + r     for center location, 

D = sqrt((d +r )^2 + r^2) – 0.40  for right and left location, 

 

where “d” is a distance of the receiver antenna from the volume diameter and “r” is radius of the volume 
diameter (in meters). 
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10.1.4. Report Format 
 

As described in section 7.4 the measurement output can be exported to a MS Excel format. Figure 56 
shows an Excel document containing several worksheets and Table 7 describes the content of the 
EXCEL file. 

 

Measurement Info Contains the same information as the Measurement Info dialog box –
general measurement information.  

Result Data Shows results computed from measured data. First column contains 
frequency values, while the others hold values for specific measured 
locations. The column headers are shortened location names (“CH” -> 
Center Horizontal). 

Limits Limit data used for the measurement 

Measurement Settings  Represents the Measurement Settings panel. 

Instruments Holds the device parameters used for measurement. 

Table 7: Description of the MS Excel file 

 

 

Figure 56: Measurement output exported to a MS Excel file. 

 

Additionally, to the measurement report it is possible to export also the raw data measured at individual 
distances at specific positions (Figure 57). 
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Figure 57: Distance scan data exported to a MS Excel file 

 

10.1.5. CalStan 10 file import limitations 
 

It is possible to open Site VSWR measurements done in CalStan 10. 

Only active trace positions are imported from the CalStan 10 Site VSWR measurement file. 

 

 

10.1.6. Literature 
 

[1] CISPR 16-1-4, Specification for radio disturbance and immunity measuring apparatus and 
methods - Part 1-4: Radio disturbance and immunity measuring apparatus - Antennas and 
test sites for radiated disturbance measurements 
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10.2. Site Attenuation SAC (Semi-anechoic chambers) 
 

Normalized site attenuation (NSA) measurements, in semi-anechoic chambers or on open area test sites, 
carried out with broadband antennas are implemented in CalStan 11 according to following standards: 

 

Standard Description and Calibration File(s) 

ANSI C63.4 The NSA method as described in ANSI C63.4 
using AFT, AFR and GSCF. The geometry data 
are taken from the GSCF info. 

CISPR 16-1-4, NSA The NSA method as described in CISPR 16-1-4 
using AFT and AFR (no setup geometry 
considered, bad procedure) 

CISPR 16-1-4, RSM The RSM (Reference Site) method as described 
in CISPR 16-1-4 using the antenna pair 
reference. The geometry data are taken from 
the APR info 

Dual Antenna Factor Method The NSA method using the DAF (Dual Antenna 
Factor). The geometry data are taken from the 
DAF info 

Table 8: List of NSA SAC standards. 

The measurement procedures described in the different standards are rather similar. Big differences can 
be found in the definition and application of the antenna factors. 

 

For all procedures the "volume method" has to be applied: This means that the transmit antenna 
connected to the signal generator has to be placed at 5 positions on the turntable. These positions are 
specified in the referenced documents. Furthermore, the transmit antenna has to be operated in two 
heights and both polarizations. The receive antenna is kept co-polarized at constant horizontal distance 
and is always facing the transmit antenna. Transmission loss between transmit and receive antenna is 
measured according to the standard test procedure (height scan of the receiving antenna) for each 
frequency and polarization. 

 

 

Figure 58: NSA SAC measurement window. 
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10.2.1. Setup 
 

Allowed measurement instrument combinations: 

 

Preferred Inst1 Inst2 Inst3 

x Network Analyser - Antenna Mast 

 Comb Generator EMI-Receiver Antenna Mast 

 - EMI-Receiver (incl. TG) Antenna Mast 

 Signal Generator Spectrum Analyser Antenna Mast 

 Comb Generator Spectrum Analyser Antenna Mast 

 

Before starting the measurement, all measurement parameters have to be defined in the "Measurement 
Settings" panel (Figure 58, upper left).  

1. First of all, select measurement standard and load appropriate antenna factor file(s) for your 
transmit and receive antennas. If the antenna factor is measured with a different frequency step, 
the data are interpolated (linear). Receive antenna and frequency range settings will be taken 
from this "antenna factor" file. 

2. Choose the frequency range for the NSA measurement. 

3. Adjust the frequency step table if needed. 

4. Set the desired limit. 

5. Set the protective attenuator (used for Vdirect measurement) or select the “none” option (double 
click the cell and choose “none” from the drop-down list). The protective attenuator value is 
added to the Vdirect measurement readout of the receiver. The Vdirect measurement value stored in 
CalStan 11 already includes the correction of the protective attenuator value. 

6. Select appropriate devices and their parameters. To operate a specific device, the correct IGPIB 
address has to be set. 

 

 

10.2.2. Measurement Procedure and Result Calculation 
 

Measure Vdirect first. To do so select the “Direct” position in the positions table (Figure 58). Connect the 
generator via the transmit cable and the receive cable to the receiver; insert two 10 dB attenuators. This 
configuration ensures that the cable loss of the receive cable is taken into account automatically. 
 

Then Vsite can be measured: 

1. Set up the antennas as required by the standard (distance, height, position, polarization). 

2. Connect the transmit antenna via one 10 dB attenuator and the transmit cable to the signal 
generator. Connect the receive antenna to the other 10 dB attenuator and via the receive cable 
with the receiver.  

3. Select the position in CalStan 11 and start the measurement. 

4. During the measurement the monitor display shows three traces: 
blue: the ideal measurement data that would obtain zero dB NSA deviation 
black: the actual measurement data for the current antenna mast height 
red: the maxhold measurement data  



51 | SEIBERSDORF LABORATORIES  CalStan 11 MANUAL |  

 

5. When measuring in vertical polarization, make sure that the cable connected to the antenna does 
not affect the measured values. For best results we recommend using a cable with ferrite rings (2 
every 10 cm) and the same cable layout of the receive antenna as used during the calibration of 
the antenna. Especially the distance between antenna and the vertical cable is important. 
 

The NSA and the deviations from the NSA (ΔSA) are calculated automatically after each measured 
position according to the selected measurement standard (see Table 9). To show the results click the 
NSA or ΔSA tab in the chart area. If at least one result is shown, the limit-lines are displayed additionally. 
The results for specific position trace are computed using the direct measurement trace which is set 
active at time of result calculation. In the NSA chart, data for selected position are grouped and displayed 
in color according to polarization and height. E.g. all horizontal upper positions (front, left, right, center, 
back) are colored and the rest is displayed in gray. 

Note: this is different to the behavior of CalStan 10 where the result was calculated using the direct trace 
that was set active at the time of measurement of that position. 

The NSA reference values need not to be specified separately. All theoretical factors are computed by 
CalStan 11 using the formulas given in the respective standards. 

 

 

ANSI C63.4 [2] 
NSA = Vdir – Vsite – AFT – AFR  – GSCF 

ΔSA = Theo - NSA 

CISPR 16-1-4, NSA [1] 
NSA = Vdir – Vsite – AFT – AFR 

ΔSA = Theo - NSA 

CISPR 16-1-4, RSM [1] ΔSA = Vdir – Vsite – SAref 

Dual Antenna Factor Method [3] 
NSA = Vdir – Vsite – DAF 

ΔSA = NSA - Theo 

where 

NSA – normalized site attenuation 

ΔSA – deviation from normalized site attenuation 

Theo - theoretical value of the site attenuation 

Vdir – direct measurement  

Vsite – values measured at the site 

AFT – transmit antenna factor 

AFR – receive antenna factor 

GSCF – geometry specific correction factor 

SAref – site reference 

DAF – dual antenna factor 

Table 9: NSA SAC results calculation for specific standards. 
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10.2.3. Report Format 
 

As described in section 7.4 the measurement output can be exported in a MS Excel format. In the picture 
below (Figure 59) you can see an Excel document containing several worksheets. 

 

 

Figure 59: Measurement output exported to a MS Excel file 

 

Measurement Info Contains general information about measurements from the 
Measurement Info dialog box 

V direct Vdirect measurement data for every measurement position. When a 
protective attenuator is selected the attenuation is automatically 
corrected. 

V site Vsite measurement data for every measured position 

Transmit antenna factor Transmit antenna factor data for every measurement position. This 
sheet is present only if one of the measurement standards 
ANSI C63.4 or CISPR 16-1-4, NSA is used. 

Receive antenna factor Receive antenna factor data for every measurement position. This 
sheet is present only if one of the measurement standards 
ANSI C63.4 or CISPR 16-1-4, NSA is used. 

Site reference factor Site reference data for every measurement position. This sheet is 
present only if the CISPR 16-1-4, RSM method is used as a 
measurement standard. 

Geometry specific correction 
factor 

Geometry specific correction factor data for every measurement 
position. This sheet is present only if the measurement standard 
ANSI C63.4 is used. 
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Dual antenna factor Dual antenna factor data for every measurement position. This 
sheet is present only if the Dual Antenna Factor method is used as 
a measurement standard. 

AN Measured NSA results computed from Vdirect, Vsite and antenna factor data. 
For some measurement standards the NSA is not computed, in 
that case this worksheet is not present. 

AN Theoretical Contains theoretically computed data for specific position 
according to used measurement standard 

Deviation ΔSA values computed as given in Table 9 

Limit Upper and lower limit data as set in the limit dialog 

Protective Attenuator Protective attenuator data if used 

Measurement Settings  Measurement Settings panel content 

Instruments Holds the device parameters used for measurement 

Table 10: Description of the MS Excel file 

Additionally, to the measurement report it is possible to export also the raw data measured at individual 
receiving antenna heights at specific positions. 

 

 

10.2.4. Literature 
 

[1] CISPR 16-1-4, Specification for radio disturbance and immunity measuring apparatus and 
methods - Part 1-4: Radio disturbance and immunity measuring apparatus - Antennas and 
test sites for radiated disturbance measurements 

[2] ANSI/IEEE C 63.4, American National Standard for Methods of Measurement of Radio-
Noise Emissions from Low-Voltage Electrical and Electronic Equipment in the Range of 9 
kHz to 40 GHz 

[3] W. Müllner, H. Garn: From NSA to Site-Reference Method for EMC Test Site Validation. 
IEEE EMC International Symposium, Montreal, Canada, August 13-17, 2001 
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10.3. Site Attenuation FAR (fully anechoic rooms) 
 

Normalized site attenuation (NSA) measurements in fully anechoic chambers, carried out with broadband 
antennas are implemented in CalStan 11 according to following standards: 

 

Standard Description and Calibration File(s) 

CISPR 16-1-4, NSA The NSA method as described in 
CISPR 16-1-4 using AFT and AFR (no 
setup geometry considered) 

CISPR 16-1-4, RSM The RSM (Reference Site) method as 
described in CISPR 16-1-4 using the 
antenna pair reference. The geometry 
data are taken from the APR info 

Dual Antenna Factor Method The NSA method using the DAF (Dual 
Antenna Factor). The geometry data 
are taken from the DAF info 

Table 11: List of NSA FAR standards. 

 

The measurement procedures are described in detail in the standards. For all procedures the "volume 
method" has to be applied: The transmit antenna connected to the signal generator has to be placed at 5 
positions in the test volume. These positions are specified in the referenced documents. Furthermore, the 
transmit antenna has to be operated in two or three heights and both polarizations. The receive antenna 
is kept co-polarized at constant horizontal distance, is always facing the transmit antenna and sometimes 
even tilted depending on the chosen procedure. Transmission loss between transmit and receive antenna 
is measured according to the standard test procedure for each frequency and polarization. 

 

 

Figure 60: NSA FAR measurement window. 
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10.3.1. Setup 
 

Allowed measurement instrument combinations: 

 

Preferred Inst1 Inst2 

x Network Analyzer - 

 Comb Generator EMI-Receiver 

 - EMI-Receiver (incl. TG) 

 Signal Generator Spectrum Analyzer 

 Comb Generator Spectrum Analyzer 

 

Before starting the measurement, all measurement parameters have to be defined in the "Measurement 
Settings" panel (Figure 60, lower left).  

1. First of all select measurement standard and load appropriate antenna factor file(s) for your 
transmit and receive antennas. If the antenna factor is measured with a different frequency step, 
the data are interpolated (linear). Receive antenna and frequency range settings will be taken 
from this "antenna factor" file. 

2. Choose the frequency range for the NSA measurement. 

3. Adjust the frequency step table if needed. 

4. Set the desired limit. 

5. Set the protective attenuator (used for Vdirect measurement) or select the “none” option (double 
click the cell and choose “none” from the drop-down list). The protective attenuator value is 
added to the Vdirect measurement readout of the receiver. The Vdirect measurement value stored in 
CalStan 11 already includes the correction of the protective attenuator value.  

6. Select appropriate devices and their parameters. To operate a specific device, the correct GPIB 
address has to be set. 

 

 

10.3.2. Measurement Procedure and Result Calculation 
 

Measure Vdirect first. To do so select the “Direct” position in the positions table (Figure 58). Connect the 
generator via the transmit cable and the receive cable to the receiver; two 10 dB attenuators shall be 
inserted. This configuration ensures that the cable loss of the receive cable is taken into account 
automatically. 

 

Then Vsite can be measured: 

1. Set up the antennas as required by the standard (distance, height, position, polarization). 

2. Connect the transmit antenna via one 10 dB attenuator and the transmit cable to the signal 
generator. Connect the receive antenna to the other 10 dB attenuator and via the receive cable 
with the receiver.  

3. Select the position in CalStan 11 and start the measurement. 

4. During the measurement the monitor display shows two traces: 
blue: the ideal measurement data that would obtain zero dB NSA deviation 
black: the actual measurement data for the current antenna mast height 
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5. When measuring in vertical polarization, make sure that the cable connected to the antenna does 
not affect the measured values. For best results we recommend using a cable with ferrite rings (2 
every 10 cm) and the same cable layout of the receive antenna as used during the calibration of 
the antenna. Especially the distance between antenna and the vertical cable is important. 

 

The NSA and the deviations from the NSA (ΔSA) are calculated automatically after each measured 
position according to the selected measurement standard (see Table 12). To show the results click the 
NSA or ΔSA tab in the chart area. If at least one result is shown, the limit-lines are displayed additionally. 
The results for specific position trace are computed using the direct measurement trace which is set 
active at time of result calculation.  

Note: this is different to the behavior of CalStan 10 where the result was calculated using the direct trace 
that was set active at the time of measurement of that position. 

The NSA reference values need not to be specified separately. All theoretical factors are computed by 
CalStan 11 using the formulas given in the respective standards. 

 

CISPR 16-1-4, NSA [1] 
NSA = Vdir – Vsite – AFT [dB/m]– AFR [dB/m] 

ΔSA = Theo – NSA 

CISPR 16-1-4, RSM [1] ΔSA = Vdir – Vsite – AAPR [dB] 

Dual Antenna Factor Method 
NSA = Vdir – Vsite – DAF [dB/m^2] 

ΔSA = NSA - Theo 

 

Where 

NSA – normalized site attenuation 

DSA – deviation from normalized site attenuation 

Theo - theoretical value of the site attenuation 

Vdirect – direct measurement 

Vsite – values measured at the site 

AFT – transmit antenna factor 

AFR – receive antenna factor 

AAPR – site reference (antenna pair reference) 

DAF – dual antenna factor 

Table 12: NSA FAR results calculation for specific standards. 
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10.3.3. Report Format 
 

As described in section 7.4 the measurement output can be exported in a MS Excel format. In the picture 
below (Figure 61) you can see an Excel document containing several worksheets. 

 

 

Figure 61: Measurement output exported to a MS Excel file 

 

Measurement Info Contains general information about measurement from 
Measurement Info dialog box 

V direct 
Vdirect measurement data for every measurement position. When 
a protective attenuator is selected the attenuation is 
automatically corrected. 

V site Vsite measurement data for every measured position 

Transmit antenna factor 
Transmit antenna factor data for every measurement position. 
This sheet is present only if the CISPR 16-1-4, NSA method is 
used as a measurement standard. 

Receive antenna factor 
Receive antenna factor data for every measurement position. 
This sheet is present only if the CISPR 16-1-4, NSA method is 
used as a measurement standard. 

APR Free Space 
Site reference data for every measurement position. This sheet is 
present only if one of the CISPR 16-1-4, RSM method is used as 
a measurement standard. 

Dual antenna factor Dual antenna factor data for every measurement position. This 
sheet is present only if the Dual Antenna Factor method is used 
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as a measurement standard. 

AN Theoretical Contains theoretically computed data for specific position 
according to used measurement standard 

Deviation ΔSA values computed as given in Table 13 

Limit Upper and lower limit data as set in the limit dialog 

Protective Attenuator Protective attenuator data if used 

Measurement Settings  Measurement Settings panel content 

Instruments Device parameters used for measurement 

Table 13: Description of the MS Excel file 

 

10.3.4. CalStan 10 file import limitations 
 

To import CalStan 10 NSA FAR file, measurement results must be computed with the current active direct 
position trace. 

 

10.3.5. Literature 
 

[1] CISPR 16-1-4, Specification for radio disturbance and immunity measuring apparatus and 
methods - Part 1-4: Radio disturbance and immunity measuring apparatus - Antennas and 
test sites for radiated disturbance measurements 
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10.4. Site Insertion Loss (Loop) 
 

Measurement of the Site Insertion Loss Deviation (∆AS) on test sites using calibrated antennas. 

 

Standard Description and Calibration File(s) 

CISPR 16-1-4, RSM Antenna Pair Referece [dB] 

CISPR 16-1-4, NSIL AFT [dBS/m] 
AFR [dBS/m] 
Theoretical NSIL [dBm2/S2] values 

CISPR 16-1-4, NSIL, Annex N Sum of Antenna Factors [dBS2/m2] 
Theoretical NSIL [dBm2/S2] values 

Table 14: List of possible measurements as defined in the standards. 

 

For all procedures the "volume method" has to be applied: This means that the transmit antenna 
connected to the signal generator has to be placed at 5 positions on the turntable. These positions are 
specified in the referenced documents. Furthermore the antennas are operated in three orientations 
X,Y,Z in one height. Site insertion loss between transmit and receive antenna is measured according to 
the standard test procedure for each frequency and orientation. 

 

 

Figure 62: Site Insertion Loss measurement window. 
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10.4.1. Setup 
 

Allowed measurement instrument combinations: 

Preferred Inst1 Inst2 Inst3 (Optional) 

x Network Analyser - Active Transmit Antenna 

 - EMI-Receiver (incl TG) Active Transmit Antenna 

 Signal Generator Spectrum Analyser Active Transmit Antenna 

 

Before starting the measurement, all measurement parameters must be defined in the "Measurement 
Settings" panel (Figure 60, lower left).  

1. First, select measurement standard and load the appropriate file(s) for used transmit and receive 
antennas. If the factors are measured with a different frequency step, the data are interpolated 
(linear). Receive antenna and frequency range settings will be taken from this "antenna factor" 
file. 

2. Choose the frequency range for the measurement. 

3. Adjust the frequency step table if needed. 

4. Set the desired limit. 

5. Select appropriate devices and their parameters. To operate a specific device, the correct GPIB 
address must be set. 

 

10.4.2. Measurement Procedure and Result Calculation 
 

Measure Vdirect first. To do so select the “Direct” position in the positions table (Figure 58). Connect the 
generator via the transmit cable and the receive cable to the receiver. This configuration ensures that the 
cable loss of the receive cable is taken into account automatically. 

 

Then Vsite can be measured: 

1. Set up the antennas as required by the standard (distance, height, position, polarization). 

2. Connect the transmit antenna via the transmit cable to the signal generator. Connect the receive 
antenna to the receive cable with the receiver.  

3. Select the position in CalStan 11 and start the measurement. 

4. During the measurement the monitor display shows two traces: 
blue: the ideal measurement data that would obtain zero dB deviation 
black: the actual measurement data for the current antenna mast height 

 

The SIL and the deviations from the deviation from the theoretical NSIL (ΔAS) are calculated 
automatically after each measured position according to the selected measurement standard (see Table 
12). To show the results click the NSA or ΔSA tab in the chart area. If at least one result is shown, the 
limit-lines are displayed additionally. 

 

The results for specific position trace are always computed using the direct measurement trace which 
was set active at the time of that position trace measurement. 
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CISPR 16-1-4, RSM ΔAs [dB] = Vdir + αATT – Vsite – Fa,TX – Fa,TX – AN 

CISPR 16-1-4, NSIL ΔAs [dB] = Vdir – Vsite – Fa,TX – Fa,TX – AN 

CISPR 16-1-4, NSIL, Annex N ΔAs [dB] = Vdir – Vsite – (DAF)- AN 

 

Where 

Δ As – site insertion loss deviation 

Fa,TX – magnetic field antenna factor of the transmit antenna 

Fa,TX – magnetic field antenna factor of the receive antenna 

DAF – Sum of antenna factors 

AN – theoretical normalized site attenuation 

αATT – Attenuator 

Vdir – direct measurement 

Vsite – values measured at the site 

Table 15: Results calculation for specific standards. 
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10.4.3. Report Format 
 

As described in section 7.4 the measurement output can be exported in a MS Excel format. In the picture 
below (Figure 63) you can see an Excel document containing several worksheets. 

 

 

Figure 63: Measurement output exported to a MS Excel file 

 

Measurement Info Contains general information about measurement from 
Measurement Info dialog box 

V direct Vdirect measurement data for every measurement position. When 
a protective attenuator is selected the attenuation is 
automatically corrected. 

V site Vsite measurement data for every measured position 

AN Measured  

AN Theoretical Contains theoretically computed data (NSIL) for specific position 
according to used measurement standard 

SA Measured Measured site insertion loss (SIL) for every measurement 
position. This sheet is present only in RSM method. 

Site reference factor Calibrated Site reference data (SIL) for every measurement 
position. This sheet is present only in RSM method. 

Transmit antenna factor Transmit antenna factor data This sheet is present only in NSIL 
method 

Receive antenna factor Receive antenna factor data This sheet is present only in NSIL 
method 

DAF Sum of Antenna factors. This sheet is present only in NSIL, 
Annex N method 
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Deviation ΔAs values computed as given in Table 13 

Limits Upper and lower limit data as set in the limit dialog 

Measurement Settings  Measurement Settings panel content 

Instruments Device parameters used for measurement 

Table 16: Description of the MS Excel file 

 

10.4.4. Literature 
 

[1] CISPR 16-1-4 Specification for radio disturbance and immunity measuring apparatus and 
methods - Part 1-4: Radio disturbance and immunity measuring apparatus - Antennas and 
test sites for radiated disturbance measurements 
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10.5. Cable Loss 
 

This plug-in allows the measurement of the attenuation of an EUT. The EUT can be a cable, an 
attenuator or any other coaxial device. By connecting the EUT to transmitter and receiver the attenuation 
is measured and evaluated with customer specific frequency resolution and range. 

 

 

Figure 64: Cable loss measurement window. 

 

The specific device under test can be selected at the top of the measurement settings panel.  
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10.5.1. Setup 
 

Allowed measurement instrument combinations: 

Preferred Inst1 Inst2  

x Network Analyser - 

 Power Meter Signal Generator  

 EMI-Receiver Comb Generator 

 Spectrum Analyser Signal Generator  

 Spectrum Analyser Comb Generator 

 

Before starting the measurement, all measurement parameters have to be defined in the "Measurement 
Settings" panel (Figure 64, lower left).  
 

1. Choose the frequency range. 

2. Adjust the frequency step table if needed. 

3. Set the protective attenuator (used for Vdirect measurement ONLY!) or select the “none” option 
(double click the cell and choose “none” from the drop-down list).  
Generally, the protective attenuator is required for conducted measurements with comb 
generators or for measurements with preamplifier to protect the receiver from overload when 
measuring Vdirect. The protective attenuator value is added to the Vdirect measurement readout of 
the receiver. The Vdirect measurement value stored in CalStan 11 already includes the correction 
of the protective attenuator value. Vcable measurements are not influenced by the protective 
attenuator. 
 
In case of cable loss measurement with a comb generator it’s advised to use the protective 
attenuator for measurement of Vdirect and Vcable. In this case do NOT select a protective attenuator 
file because it is present in both measurements and has no effect on the measured attenuation. 

4. Select appropriate devices and their parameters. To operate a specific device, the correct GPIB 
address has to be set. 

 

 

10.5.2. Measurement Procedure and Result Calculation 
 

Measure Vdirect. Select the “Direct” position in the positions table (Figure 58). Connect the generator to the 
receiver via the auxiliary cable. This configuration ensures that the cable loss of the auxiliary cable is 
taken into account automatically. If you selected a protective attenuator in the measurement settings 
dialog plug it now between transmitter and auxiliary cable. The measurement value stored in CalStan 11 
is the receiver readout plus the protective attenuator value. 

Measure Vcable: 
Connect the EUT between the auxiliary cable and the receiver. Make sure to remove the protective 
attenuator when selected in the measurement settings.  
Select the position (e.g. Measurement 1) in CalStan 11 and start the measurement. 
During the measurement the monitor window shows the current measurement data. 
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After the measurement is finished, results are calculated using the formula: 
 

CL = Vdirect - Vcable 
 
where Vdirect – direct measurement value 
 Vcable – measured value 

 

At the beginning there are only two positions - Direct and Measurement 1. Right mouse click displays the 
context menu where new measurement position can be added. Measurement position names can be 
edited by double clicking the name cell. 

 

10.5.3. Report Format 
 

As described in section 7.4 the measurement output can be exported in MS Excel format. The picture 
below (Figure 65) shows an Excel document containing several worksheets. 

 

 

Figure 65: Measurement output exported to a MS Excel file 
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Measurement Info Contains general information about measurement from 
Measurement Info dialog box 

V direct Vdirect measurement data for every measured position. When a 
protective attenuator is selected the attenuation is corrected 
automatically. 

V cable Vcable measurement data for every measured position 

Attenuation Measurement results 

Protective Attenuator Protective attenuator data if used 

Measurement Settings  Measurement Settings panel content 

Instruments Holds the device parameters used for measurement 

Table 17: Description of the MS Excel file 
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10.6. Experimental Measurement 
 

Experimental Measurement plug-in is designed to perform measurements which are not strictly bound to 
any measurement type and standard. Measurement values (level, loss, VSWR) are collected with or 
without height scan and optional cable loss correction. If a reference position is measured the result is 
calculated as deviation from the reference. If an antenna factor is loaded the field strength is calculated.  

 

 

Figure 66: Experimental Measurement window. 

 

To document specific measurement layout (e.g. antenna positions), it is possible to load pictures for every 
measurement in the positions table. Click the “Load” button to load a picture from disk, use “View” button 
to show a preview dialog where all loaded pictures for selected position can be managed (see Figure 41). 
Right click on the pictures list in the context menu to rename, delete or select the picture as default. 
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10.6.1. Setup 
 

Allowed measurement instrument combinations: 

Preferred Inst1 Inst2 (b1 only) Inst3 (optional) 

x Network Analyser - Antenna Mast 

 EMI-Receiver Comb Generator Antenna Mast 

 Spectrum Analyser Signal Generator  Antenna Mast 

 Spectrum Analyser Comb Generator Antenna Mast 

 

Before starting the measurement following measurement parameters have to be defined in the 
"Measurement Settings" panel (Figure 66, lower left).  

 

1. Choose the frequency range. 

2. Adjust the frequency step table if needed. 

3. Optionally set the receive antenna parameters to adjust height scan (see 7.1). 

4. Optionally set receiver antenna factor or cable loss factor file. Cable loss measurement 
performed by CalStan can also be used here. Don’t forget to select the correct result column from 
the combo box in the data tab as described in 7.1.3 

5. Optionally set the protective attenuator (used for Reference measurement ONLY!) or select the 
“none” option (double click the cell and choose “none” from the drop-down list).  
Generally, the protective attenuator is required for conducted measurements with comb 
generators or pre-amplifiers to protect the receiver from overload at the Reference measurement. 
The protective attenuator value is added to the Reference measurement readout of the receiver 
and stored in CalStan 11. Other measurements are not influenced by the protective attenuator. 
See next section for more details. 

6. Select appropriate devices and their parameters. To operate a specific device, the correct 
address must be set. 

 

10.6.2. Measurement Procedure and Result Calculation 
 

In the experimental measurement there are two measurement types: 
 

The reference measurement MR - done only once - serves as reference according to which the results 
are computed. It’s represented by the “Reference” position at the top of the positions table (see Figure 
66). Protective attenuator data and cable loss data are added to readout values if their unit is dB or dBm.  

A multitude of measurement Mx can be performed. By clicking the positions table “New measurement” 
menu item (see Figure 67) a new measurement is added at the bottom of the list. The name of the 
measurement is set to current date & time by default but can be changed anytime. No protective 
attenuator data but cable loss is added to the measured values. 
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Figure 67: Adding new measurement in the positions table 

 

 

Results are computed as following: 

 

MR = Readout + cl + pa 

MX = Readout + cl 

 

where 

 cl:  cable loss factor value (if available) 

 pa:  protective attenuator (if available) 

 

If receive antenna factor file is set and measurement data unit is dBm, the field strength E [dBµV/m] is 
calculated according to the following formula and a “Field strength” chart tab is then added in the charts 
panel: 

 

E = M + 107 + afr 

 

Where 

M:  measured value (MR or MX) [dBm] 

 afr:  receive antenna factor value [dB/m] 

 

When custom measurement is finished, and reference measurement is available the difference D [dB] of 
reference measurement and the custom measurement is computed and displayed in a separate 
“Deviation” tab in the charts panel. 

 

The results for specific position traces are always computed using the direct measurement trace which 
was set active at the time of that position trace measurement. 

 

D = MR - Mx 
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10.6.3. Report Format 
 

As described in section 7.4 the measurement output can be exported in a MS Excel format. In the picture 
below (Figure 68) you can see an Excel document containing several worksheets. 

 

Figure 68: Measurement output exported to a MS Excel file 

 

Measurement Info Contains general information about measurement from 
Measurement Info dialog box 

Measurements Measured data 

Field Strength Computed field strength 

Deviation Measurement results 

Receive Antenna Factor* Receive antenna factor data 

Cable loss* Cable loss data 

Protective Attenuator* Protective attenuator data 

Measurement Settings  Measurement Settings panel content 

Instruments Device parameters used for measurement 

* worksheets are added only if factor files are used 

Table 18: Description of the MS Excel file 
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11. TROUBLESHOOTING 
 

11.1. Device is detected as UNKNOWN although it supports *IDN? 
Query. 

 

Possible reasons:  

a) The device responds with incompatible string. Correct string format is e.g. Rohde&Schwarz,ESU-
40,100031/040,4.23  (manufacturer, model, serial number, firmware version) 

b) The device responds too slowly. In this case device has to be selected manually from the drivers 
list.  

 

11.2. Measurement fails with error message "error -420: Query 
unterminated INIT*OPC"  

 

Disable serial auto polling in the GPIB card properties 

 

 

Figure 69: Disabling Serial Polling in the GPIB card configuration 
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11.3. Measurement fails with error message "error -108: Parameter 
not allowed”  

 

This may be a decimal separator problem in the device driver Try to change you regional settings and use 
“.” As decimal and “ ” as thousands separator. Please let us know about this problem. 

 

 

11.4. “No instrument found” message appears on device detection 
 

a) The network connected devices have to be defined in the NI Max software. 

 

 
Note: If the instrument uses specific TCP/IP port e.g. select the “Manual Entry of Raw Socket”. 
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b) If devices are detected/defined in the National Instruments Measurement & Automation software 
but CalStan can’t find them National Instruments software has to be reinstalled with latest 
version. 
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11.5. “Problem with parameter: Preamplifier” message appears on 
device selection 

 

 
The measurement file is not compatible with the given device driver. 

If this happends on creating new measurement. The given measurement template have to be deleted. 

 

11.6. Communication with the device doesn’t work using USB cable 
 

Try to use USB 2.0 cable. 

 

11.7. Communication with the TCP/IP device doesn’t work. 
 

In some cases, the communication between the measurement device and the PC is blocked a firewall. 
This could be a software firewall like the Windows Defender Firewall, or an additional firewall introduced 
by VPN software. A hardware firewall may be the reason if the PC and the measurement device are 
operating on different IP subnets. 

Extensive information about the correct configuration can be found at: 

https://www.ni.com/en-us/support/documentation/supplemental/10/configuring-software-and-hardware-
firewalls-to-support-national-.html 

 

 

11.8. Measurement with spectrum analyzer is extremely slow 
 

Disable serial auto polling for slow measurement with signal generator/spectrum analyzer (see 11.2) 

 

11.9. Operation finished with error -1073807342  
Check the serial number of the GPIB card on NI.com. The cards is probably not original, but cheap copy. 

 

https://www.ni.com/en-us/support/documentation/supplemental/10/configuring-software-and-hardware-firewalls-to-support-national-.html
https://www.ni.com/en-us/support/documentation/supplemental/10/configuring-software-and-hardware-firewalls-to-support-national-.html
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